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Введение

Цель написания этой книги – открыть читателям новые углубленные техни-
ки использования такого привычного, казалось бы, инструмента, как Excel. 
За 20 лет преподавания и консультирования я изучил огромное количество 
тонкостей и нюансов применения Excel, освоил не самые очевидные техники 
написания формул и хочу поделиться этим с вами.

Microsoft Excel используется в офисной работе повсеместно для ведения 
учета и анализа данных. Но при этом подавляющее большинство пользовате-
лей Excel обладают лишь базовыми навыками этого богатого программного 
продукта, познакомившись с ним в институте или прочитав пару статей в ин-
тернете. Они нажимают какие-то кнопки, щелкают мышкой, зачастую даже 
не понимая, как получается нужный им результат. В этой книге я постараюсь 
открыть вам некоторые тайны и секреты Excel и научить пользоваться этим 
мощным инструментом на совершенно новом уровне.

Книга, которую вы держите в руках, будет полезна всем, кто активно ис-
пользует Excel в своей работе вне зависимости от профессии и требований 
к программе.

Содержание глав книги:
�� глава 1. В  данной главе мы сосредоточимся на техниках и  приемах, 

которые помогут вам повысить эффективность использования Excel 
на практике, – я поделюсь с вами навыками, полученными за долгие 
годы работы и преподавания;

�� глава 2. Эта глава будет целиком посвящена формулам и некоторым 
предельно полезным функциям Excel. Вы глубоко погрузитесь в мир 
формул Excel и  узнаете о  них то, чего не знали раньше. После этого 
я познакомлю вас с несколькими крайне эффективными функциями 
для анализа данных и создания динамических отчетов с использова-
нием реальных примеров;

�� глава 3. Здесь мы познакомимся с продвинутыми техниками форма-
тирования, способными придать вашим данным значимости. Начнем 
с углубленного изучения условного форматирования, после чего вы-
ведем эту технику на новый качественный уровень с помощью поль-
зовательского форматирования;

�� глава 4. В данной главе вы узнаете массу приемов, облегчающих и улуч-
шающих процесс создания диаграмм в Excel. Речь пойдет в том чис-
ле об автоматическом изменении цветов для ключевых показателей, 
динамической сортировке данных и креативном подходе к созданию 
меток на диаграммах;

�� глава 5. Эта глава позволит вам познакомиться с одной из важнейших 
новинок в  Excel за последние несколько лет – инструментом Power 
Query. Мы пройдемся по нескольким практическим примерам загрузки 
и подготовки данных для анализа с использованием Power Query;
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�� глава 6. Заключительная глава книги будет посвящена Power Pivot – 
надстройке, выходящей за границы традиционного использования 
рабочих листов в  Excel. С  помощью Power Pivot вы сможете хранить 
большие объемы информации, создавать модели данных и произво-
дить мощные вычисления.

Демонстрационные файлы
Вы можете загрузить файлы примеров, используемые на протяжении всей 
книги, чтобы попрактиковаться с ними самостоятельно. Учиться лучше все-
го на практике. Следуйте инструкциям, исследуйте примеры и набирайтесь 
опыта.

 

http://www.apress.com/gp/book/9781484264669


Глава 1
Приемы Excel 

и инструменты 
для работы с данными

Наверное, все любят приемчики в Excel. Я так точно люблю. Обожаю нахо-
дить всякие фишечки и неизвестные мне ранее нюансы и использовать их 
в работе. Это позволяет мне постоянно узнавать что-то новое.

Зачастую при решении определенной задачи в Excel ответ находится со-
всем не там, где ожидаешь. К примеру, он может быть скрыт в инструменте, 
который, как казалось до этого, вы прекрасно знаете. Но вдруг вас осеняет, 
и  ставший доступным вам очередной прием открывает новые горизонты. 
Вы начинаете судорожно думать, где бы еще его применить на практике. 
Я обожаю это чувство.

В данной главе я поделюсь с вами приемами и трюками, которые открыл 
для себя за последние годы. Этими находками я обязан своим друзьям, сту-
дентам и, конечно, собственной любознательности. Надеюсь, многим из вас 
эти приемы помогут облегчить свою рутинную работу.

Техники заполнения

Давайте начнем с несложных техник заполнения. Это, наверное, одни из пер-
вых приемов, которые люди осваивают при знакомстве с Excel, но и здесь 
есть нюансы, о которых знают далеко не все.

Генерация числовых последовательностей
Как вы, наверное, знаете, для генерации простых числовых последователь-
ностей (например, при создании порядковых номеров)  заполнения одной 
ячейки недостаточно, поскольку по умолчанию Excel просто скопирует ее 
значение во все соседние ячейки.

Alexander Ginko
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1.	� Введите первое число из последовательности (в  нашем примере это 
единица) в  ячейку, затем выделите ее и  наведите курсор на маркер 
заполнения (fill handle) в нижнем правом углу ячейки, показанный на 
рис. 1.1, чтобы появилось перекрестие.

2.	� С зажатой левой кнопкой мыши протяните вниз на столько ячеек, 
сколько хотите заполнить значениями.

В каждой из затронутых ячеек появится то же число, которое было введено 
в исходную ячейку, что видно по рис. 1.2.

Рис. 1.1   Использование маркера 
заполнения для генерации числовых 

последовательностей

Рис. 1.2   При протягивании  
одной ячейки вниз остальные ячейки 

заполняются тем же значением

Ввод отличающегося числового значения в соседнюю с исходной ячейку 
позволит создать требуемую последовательность, как показано на рис. 1.3.

Но вам нет никакой необходимости делать все это. В Excel можно сгене-
рировать нужную вам последовательность и гораздо проще. Просто введите 
в ячейку число и заполняйте соседние ячейки как показано выше, но с за-
жатой клавишей Ctrl.

Альтернативный способ состоит в  задействовании «волшебной» ячейки 
справа. Выделите эту ячейку вместе с исходной и просто протягивайте вниз, 
как показано на рис. 1.4.

Рис. 1.4   Использование 
«волшебной» ячейки справа 

для генерации последовательностиРис. 1.3   Использование 
двух чисел для генерации 

последовательности
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Дополнительные опции последовательностей
Доступ к дополнительным опциям последовательностей можно получить, 
если переместить маркер заполнения из исходной ячейки и  обратно с  за-
жатой правой кнопкой мыши. После отпускания кнопки мыши вы увидите 
меню, показанное на рис. 1.5. Выберите пункт Прогрессия... (Series...).

Рис. 1.5   Нажмите правую кнопку мыши,  
выведите заполнения из ячейки и верните обратно,  

чтобы открыть секретные опции

Примечание. Доступ к этим опциям можно также получить, открыв пункт меню Главная 
⇒ Заполнить ⇒ Прогрессия (Home ⇒ Fill ⇒ Series).

Диалоговое окно Прогрессия (Series), показанное на рис. 1.6, предостав-
ляет богатые возможности в плане создания последовательностей, в числе 
которых заполнение по строкам или столбцам и выбор шага и предельного 
значения для последовательности.

Давайте для примера создадим последовательность с шагом 2 и предель-
ным значением 15. Результат показан на рис. 1.7.

Это лишь один из примеров того, что можно сделать. Теперь давайте по-
смотрим на более реалистичный сценарий.

Alexander Ginko

Alexander Ginko
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Рис. 1.6   Дополнительные опции 
в диалоговом окне Прогрессия Рис. 1.7   Числовая 

последовательность  
от 1 до 15 с шагом 2

Перед нами стоит задача создания списка дат с 3 марта 2020 года по 30 октя-
бря 2022 года с двухнедельным интервалом (3 марта 2020 года – это вторник).

1.	� Введите значение 03/03/2020 в исходную ячейку и откройте диалоговое 
окно Прогрессия.

2.	� Excel автоматически определит, что вы собираетесь строить последова-
тельность дат. Убедитесь, что в группе Тип (Type) выбран пункт Даты 
(Date), а в группе Единицы (Date unit) – День (Day).

3.	� Введите число 14 в поле Шаг (Step value) и 30/10/2022 – в поле Предель-
ное значение (Stop value). Полностью заполненное окно Прогрессия 
показано на рис. 1.8.

4.	� Нажмите на кнопку OK.

Сгенерированный список будет выглядеть так, как показано на рис. 1.9. 
Этот способ куда легче, чем вводить две даты в ячейки и протягивать маркер 
заполнения вниз до 30 октября 2022 года.

Рис. 1.8   Последовательность дат 
с предельным значением

Рис. 1.9   Список дат 
с двухнедельным интервалом, 
начиная с 2 марта 2020 года

Alexander Ginko
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В данном случае последовательность дат продлилась до 25 октября 2022 го
да – это последний вторник из выбранного интервала.

Невероятное мгновенное заполнение
Инструмент мгновенного заполнения (Flash Fill) появился в Excel версии 2013, 
и, когда я впервые опробовал его в работе, я ночь не спал. Наряду с Power 
Query, о котором мы поговорим в главе 5, этот механизм значительно об-
легчил выполнение задач, которые ранее занимали уйму времени.

Давайте рассмотрим на примерах, что и  как умеет делать инструмент 
мгновенного заполнения. Сразу скажу, что мы лишь познакомимся с осно-
вами этой концепции, а глубже изучить вы ее сможете самостоятельно.

Файл: flash-fill.xlsx

В первом примере у  нас есть список людей, имена которых записаны 
в столбце A, а фамилии – в столбце B. В столбце C мы хотим соединить их 
вместе.

Введите имя и фамилию первого человека в списке и нажмите на клави-
шу Enter. Начните писать имя второго человека, и механизм мгновенного 
заполнения угадает ваши намерения и предложит дополнить текст автома-
тически, как показано на рис. 1.10. Нажмите на клавишу Enter, чтобы под-
твердить действие и заполнить список до конца.

Рис. 1.10   Мгновенное заполнение  
автоматически подбирает нужный шаблон

Как же легко оказалось объединить вместе имена и фамилии людей, даже 
не прибегая к помощи формул.

Примечание. Вы можете отключить механизм автоматического заполнения в параме-
трах Excel, если вам не нужно такое поведение.
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Для второго примера заполним столбец A кодами, как показано на рис. 1.11, 
и  предположим, что во втором столбце нам необходимо извлечь из кодов 
содержимое между двумя дефисами. Одновременно желательно перевести 
извлеченные фрагменты кодов в верхний регистр.

Если пользоваться для этого формулой, она окажется весьма непростой 
для понимания, но с механизмом мгновенного заполнения все просто.

1.	� Встаньте в ячейку B2 и введите буквы JH в верхнем регистре.
2.	� Нажмите сочетание клавиш Ctrl+Enter, чтобы подтвердить ввод, но 

остаться при этом в ячейке B2.
3.	� Нажмите сочетание клавиш Ctrl+E, активирующее мгновенное запол-

нение.

Да, вот так просто мы извлекли данные, необходимые нам для дальнейше-
го анализа. Результат показан на рис. 1.12.

Примечание. Механизм мгновенного заполнения также можно запустить, выбрав 
в меню Главная ⇒ Заполнить ⇒ Мгновенное заполнение (Home ⇒ Fill ⇒ Flash Fill or 
Data ⇒ Flash Fill).

Рис. 1.11   Список кодов 
с информацией для извлечения

Рис. 1.12   Готовое решение, 
полученное при помощи 
мгновенного заполнения

Преимущества настраиваемых списков

Когда вы вводите название месяца или дня недели в Excel и протягиваете 
ячейки, автоматически создаются правильные последовательности, что вид-
но по рис. 1.13. Это возможно по причине того, что Excel хранит подобные 
последовательности в виде настраиваемых списков (custom lists).

Но вы можете создавать собственные настраиваемые списки в Excel. Это 
поможет увеличить скорость и точность ввода последовательностей данных 
в будущем, что весьма и весьма полезно.

Еще одно применение настраиваемых списков состоит в выполнении эф-
фективной сортировки данных. У вас есть возможность сортировать столбцы 
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в соответствии со списками, но что, если элементы в нем расположены не 
в том порядке, как вам нужно?

Предположим, у нас есть срез (slicer) для фильтрации данных в умной таб­
лице (table) или сводной таблице. В нем содержатся дни недели, отсортиро-
ванные в определенном порядке, как показано на рис. 1.14. Но, быть может, 
для вас первым днем недели является не понедельник (Monday), а воскресе-
нье (Sunday). Таким образом, вы бы хотели, чтобы именно этот день недели 
располагался первым при выполнении сортировки.

Рис. 1.13   Последовательность  
из дней недели в Excel

Рис. 1.14   Срез с днями недели, 
отсортированный при помощи 

стандартного списка

Чтобы создать собственный настраиваемый список, вам необходимо вы-
полнить следующие действия.

1.	� Перейти в меню Файл ⇒ Параметры ⇒Дополнительно ⇒ Изменить 
списки (File ⇒ Options ⇒ Advanced ⇒ Edit Custom Lists), как показано 
на рис. 1.15.

2.	� Вы не можете редактировать встроенные списки, так что придется 
создать собственный. С выбранным элементом НОВЫЙ СПИСОК (NEW 
LIST) в окне Список (Custom lists) введите дни недели в нужном вам 
порядке в правом окне Элементы списка (List entries). После каждого 
введенного элемента нажимайте на клавишу Enter. Готовый список 
показан на рис. 1.16.

3.	� Нажмите на кнопку Добавить (Add) для перемещения созданного спи-
ска в левое окно, после чего нажмите на кнопку OK для закрытия окна.

Примечание. Вы также можете импортировать список из диапазона ячеек при помощи 
кнопки Импорт (Import).
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Рис. 1.15   Кнопка Изменить списки (Edit Custom Lists)  
в меню Дополнительно (Advanced)

Рис. 1.16   Создание своего настраиваемого списка дней недели
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Созданный список можно использовать для сортировки в срезе.

1.	� Выделите срез и  выберите в  меню пункт Срез ⇒ Настройка среза 
(Slicer ⇒ Slicer Settings).

2.	� Убедитесь, что флажок Использовать настраиваемые списки при 
сортировке (Use Custom Lists when sorting) включен, как показано 
на рис.  1.17. При этом вам может понадобиться сортировать данные 
в порядке убывания, после чего вы можете вернуться к сортировке по 
возрастанию.

Рис. 1.17   Использование настраиваемых списков  
для выполнения сортировки среза

Элементы среза теперь отсортированы в нужном нам порядке, что видно 
по рис. 1.18.

Создание собственных настраиваемых списков для хранения названий ме-
сяцев или дней недели – это довольно распространенный способ использо-
вания этой возможности. К тому же в разных сценариях могут понадобиться 
разные первые месяцы.

Кроме того, настраиваемые списки можно использовать и довольно твор-
чески. Представьте, что вы осуществляете продажи в  разных странах, что 
отражено в срезе (или сводной таблице). При этом в двух странах – Герма-
нии (Germany) и Швейцарии (Switzerland) – у вас расположены флагманские 
магазины, и вы хотели бы всегда видеть их на вершине списка для удобства.

Создание настраиваемого списка, показанного на рис. 1.19, в котором нуж-
ные нам страны расположены наверху, и использование его для сортировки 
обеспечит нам желаемый результат.

Alexander Ginko
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Рис. 1.18   Срез,  
отсортированный в соответствии 

с настраиваемым списком
Рис. 1.19   Настраиваемый список 
с требуемой сортировкой по странам 

для среза

Одновременное изменение нескольких 
рабочих листов

Иногда у вас возникает потребность изменить одновременно несколько ра-
бочих листов: удалить столбцы, отформатировать ячейки или вписать в них 
формулы. Это можно легко реализовать путем группировки листов.

В демонстрационном файле group-worksheets.xlsx присутствует пять листов 
с квартальными продажами товаров. Каждый лист представляет собой отчет 
одного магазина, и  мы хотим сделать определенные изменения. Рабочая 
книга показана на рис. 1.20.

Рис. 1.20   Пять рабочих листов с данными

Alexander Ginko

Alexander Ginko
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Чтобы произвести изменения на всех листах одновременно, необходимо 
щелкнуть правой кнопкой мыши на закладке с листами и выбрать пункт Вы-
делить все листы (Select All Sheets), как показано на рис. 1.21.

Рис. 1.21   Выделение всех рабочих листов

Все листы сгруппированы, что можно понять по слову Группа (Group) 
в строке заголовка рядом с названием рабочей книги (рис. 1.22).

Рис. 1.22   Группировка листов в заголовке рабочей книги

Теперь можно приступать к изменениям на листе, и все они будут проду-
блированы на остальных листах, входящих в группу.

В нашем случае заголовки таблицы были выделены жирным шрифтом, 
а в строке 8 была использована функция СУММ (SUM) для подведения ито-
гов по кварталам, при этом сами ячейки итогов были обрамлены верхними 
и нижними границами, а формат в них был изменен на числовой, как по-
казано на рис. 1.23.
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Рис. 1.23   Форматирование и применение формул  
на сгруппированных листах

Чтобы разгруппировать объединенные листы, просто щелкните по заклад-
ке неактивного рабочего листа.

Примечание. Можно сгруппировать не все листы, а  выборочные. Для этого необхо-
димо выделить их в закладках с зажатой клавишей Ctrl. Диапазоны последовательно 
расположенных листов можно выбрать, указав первый и последний из них с зажатой 
клавишей Shift.

Трюки с диалоговым окном Найти и заменить

Инструмент Найти и заменить (Find and Replace) у пользователей Excel за-
частую остается незаслуженно забытым. Ему уже много лет, и он неприметно 
ютится в дальней части вкладки Главная (Home) на ленте, что не добавляет 
ему популярности.

Но зачастую возможности, которые предлагает этот механизм, просто 
неуместно заменять использованием причудливых формул, макросов или 
новых инструментов вроде Power Query. Иногда нужно просто выполнить 
задачу. И здесь на помощь приходит старое доброе диалоговое окно Найти 
и заменить.

Файл: find-and-replace.xlsx

Найти и заменить в рабочей книге
Начнем с того, что способно здорово сэкономить вам время, а именно с заме-
ны, удаления и форматирования значений в ячейках во всей рабочей книге 
при помощи нескольких щелчков мыши.

Alexander Ginko

Alexander Ginko
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Итак, у нас есть три рабочих листа: North East, North West и South (конечно, 
их может быть и больше), и нам необходимо сделать определенные измене-
ния на всех из них.

В данном примере мы хотим изменить наименование товара с Supreme 
Pizza на Mega Pizza. Причем мы должны произвести замену на всех листах.

1.	� Откройте диалоговое окно Найти и заменить (Find and Replace), вос-
пользовавшись сочетанием клавиш Ctrl+H или перейдя по меню Главная 
⇒ Найти и выделить ⇒ Заменить (Home ⇒ Find & Select ⇒ Replace).

2.	� Введите строку «Supreme Pizza» в  поле Найти (Find) и  строку «Mega 
Pizza» в поле Заменить на (Replace with).

3.	� Нажмите на кнопку Параметры (Options) для открытия дополнитель-
ных настроек.

4.	� Измените значение в  списке Искать (Within) с  На листе (Sheet) на 
В книге (Workbook). Полностью заполненное диалоговое окно показа-
но на рис. 1.24.

Рис. 1.24   Заменяем все вхождения строки «Supreme Pizza» в книге

5.	� Нажмите на кнопку Заменить все (Replace All).

Все вхождения строки «Supreme Pizza» 
в рабочей книге будут изменены на «Mega 
Pizza». При этом появится подтверждение 
с указанием количества произведенных за-
мен, представленное на рис. 1.25. Если за-
мен было выполнено больше, чем вы ожи-
дали, вы всегда можете отменить последнее 
действие и уточнить критерий поиска.

Примечание. Инструмент Найти и заменить является достаточно мощным, но при этом 
требует внимательного обращения. Уточняющее слово «Pizza» было включено в поиск, 
чтобы не затронуть другие товары, в которых есть слово «Supreme».

Рис. 1.25   Подтверждение 
успешной замены строк в книге
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Быстрое редактирование формул
По умолчанию инструмент Найти и заменить выполняет поиск и замену 
в формулах ячеек. Это может быть очень полезно при массовом редактиро-
вании формул.

На тех же трех листах North East, North West и South для анализа данных 
были использованы формулы. Один из примеров формулы:

=СУММЕСЛИМН($C$2:$C$21;$A$2:$A$21;E3) 

Здесь используются ссылки на лист. Ссылка $C$2:$C$21 обращается к диа-
пазону с цифрами продаж на текущем листе. Сама же таблица у нас теперь 
оформлена как умная, так что хотелось бы, чтобы наши ссылки приобрели 
новый вид, – это будет более эффективно.

Таблицы на листах названы соответственно NorthEast, NorthWest и South 
(пробелы в именах таблиц недопустимы). Пример таблицы NorthEast показан 
на рис. 1.26.

Рис. 1.26   Таблица NorthEast со столбцом Sales

Давайте посмотрим, как можно быстро заменить ссылки в столбце с про-
дажами.

1.	� Откройте диалоговое окно Найти и заменить.
2.	� Введите строку «C$2:$C$21» в поле Найти и строку «NorthEast[Sales]» 

в поле Заменить на.
3.	� Нажмите на кнопку Параметры для открытия дополнительных на-

строек.
4.	� В списке Искать выберите пункт На листе. На всех листах нам нужно 

будет выполнять эту операцию отдельно, поскольку таблицы названы 
по-разному.

5.	� Убедитесь, что в списке Область поиска (Look in) стоит значение Фор-
мулы (Formulas). Полностью заполненное диалоговое окно показано 
на рис. 1.27.

Alexander Ginko
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Рис. 1.27   Быстрое редактирование всех формул на листе

6.	� Нажмите на кнопку Заменить все (Replace All).

Примечание. Настройки диалогового окна сохраняются между вызовами. Это бывает 
удобно, если вы регулярно используете эту опцию в работе, но и таит некоторые опас-
ности. Не забывайте очищать предыдущие настройки окна перед выполнением нового 
поиска.

Изменение формата ячеек
Да, это так. При помощи диалогового окна Найти и заменить можно даже 
находить, изменять и удалять настройки форматирования ячеек.

К ячейкам с формулами на листах North East, North West и South применен 
специфический формат. Это хорошая идея, поскольку так ячейки с форму-
лами легко отличать от остальных.

И если вы захотите изменить особенности форматирования этих ячеек, вы 
можете с легкостью сделать это при помощи все того же диалогового окна 
Найти и заменить.

1.	� Откройте диалоговое окно Найти и заменить.
2.	� Нажмите на кнопку Параметры для открытия дополнительных на-

строек.
3.	� Справа от поля Найти нажмите на стрелку рядом с кнопкой Формат 

(Format), выберите пункт Выбрать формат из ячейки (Choose Format 
From Cell), как показано на рис. 1.28, и выделите любую ячейку с фор-
мулой.

4.	� Нажмите либо на саму кнопку Формат (Format) справа от поля Заме-
нить на, чтобы указать форматирование вручную, либо на стрелку спра-
ва от нее и также выберите пункт Выбрать формат из ячейки (Choose 
Format From Cell), если на листе есть ячейки с нужным форматом.

Alexander Ginko
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Рис. 1.28   Выбор формата из ячейки

5.	� В списке Искать выберите пункт В  книге. Полностью заполненное 
диалоговое окно показано на рис. 1.29.

Рис. 1.29   Изменение форматирования  
при помощи инструмента Найти и заменить

6.	� Нажмите на кнопку Заменить все (Replace All).

Удаление значений
Инструмент Найти и заменить, несмотря на свое название, не только отлич-
но справляется с поиском и заменой значений и элементов форматирования, 
но также может быть использован для выборочного удаления данных.

На рис.  1.30 показаны первые десять строк таблицы с  продажами, в  ко-
торую также включены строки с  итогами (Total). Для более эффективного 
анализа нам необходимо удалить эти строки.

Alexander Ginko
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Рис. 1.30   Исходная таблица  
со строками для удаления

1.	� Откройте диалоговое окно Найти и заменить.
2.	� Введите строку «Total» в поле Найти.
3.	� В списке Искать выберите пункт На листе.
4.	� Установите флажок Ячейка целиком (Match entire cell contents). Мы 

хотим убедиться, что в  удаляемых ячейках будет находиться только 
искомое слово.

5.	� Нажмите на кнопку Найти все (Find All). Список всех найденных ячеек, 
включая информацию об их адресах, будет показан ниже. Заполненное 
диалоговое окно с выполненным поиском показано на рис. 1.31.

Рис. 1.31   Поиск всех ячеек, содержащих слово «Total»
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6.	� Убедитесь, что окно со списком найденных ячеек является активным, 
и нажмите сочетание клавиш Ctrl+A для выделения всех ячеек, как по-
казано на рис. 1.32.

7.	� Нажмите на кнопку Закрыть (Close).

Рис. 1.32   Выбор всех найденных ячеек

8.	� Перейдите в  меню Главная ⇒ Удалить ⇒ Удалить строки с листа 
(Home ⇒ Delete ⇒ Delete Sheet Rows), как показано на рис. 1.33.

Рис. 1.33   Удаление выбранных ячеек на листе

Удаление звездочек (*) из диапазона
Повсеместно используется два основных знака подстановки, которые вы 
можете применять в  качестве критерия для поиска. Это вопросительный 
знак (?) и звездочка (*).
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Эти знаки могут использоваться вместо симво-
лов, в которых вы не уверены. При этом вопроси-
тельный знак замещает собой один символ – на-
пример, строка «A?an» может означать и «Adam», 
и  «Alan». В то же время звездочка используется 
вместо любого количества неизвестных симво-
лов. К примеру, строка «L*n» может быть замене-
на на «London» или «Linton».

Если эти символы используются в  качестве 
знаков подстановки, как вам найти их при не-
обходимости?

Рассмотрим сценарий, показанный на рис. 1.34. 
При импорте данных имена в таблице были об-
рамлены символами звездочек, и нам нужно из-
бавиться от них.

В данном случае мы можем использовать спе-
циальный символ «тильда» (~) перед звездочкой в поле Найти, как показано 
на рис. 1.35. Оставьте поле Заменить на пустым, чтобы ничем не заменять 
эти символы, и нажмите на кнопку Заменить все.

Рис. 1.35   Использование тильды для поиска звездочек

Тильда информирует инструмент Найти и заменить о том, что следую-
щий за ней символ должен использоваться в составе критерия поиска, а не 
в качестве знака подстановки.

Примечание. Этот символ также может быть использован для замены или удаления зна-
ков вопроса. Если же вам необходимо обработать сам символ «тильда», используйте 
сдвоенный знак в строке поиска (~~).

Рис. 1.34   Список 
импортированных имен, 

включая знаки подстановки
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Быстрая замена символов переноса строки
Перенос строки –  еще один надоедли-
вый символ, от которого частенько при-
ходится избавляться на листах Excel, 
особенно если вы работаете с данными, 
полученными из внешних источников. 
И с этим также легко может справиться 
инструмент поиска и замены.

На рис. 1.36 показан фрагмент листа, 
на котором символы переноса строки 
используются для разделения имен.

1.	� Выделите диапазон с  именами 
и откройте диалоговое окно Най-
ти и заменить.

2.	� Встаньте в поле Найти и нажмите 
сочетание клавиш Ctrl+J. В резуль-
тате в строку поиска будет вставлен невидимый знак перевода строки.

3.	� В поле Заменить на введите запятую и  пробел (, ), как показано на 
рис. 1.37.

Рис. 1.37   Избавление от символов переноса строки  
при помощи инструмента Найти и заменить

4.	� Нажмите на кнопку Заменить все для подмены запятыми всех знаков 
перевода строки.

5.	� Нажмите на кнопку Перенести текст (Wrap Text) на вкладке Главная 
(Home), чтобы отменить перенос строк, активированный соответствую
щими символами.

Примечание. Символ переноса строки имеет код 10 в операционной системе Windows 
и 13 – в Mac. Вы можете заменить эти знаки и с использованием функции CHAR с ука-
занием соответствующего кода, заключенной внутрь функции SUBSTITUTE, если вам 
необходимо сделать это при помощи формул.

Рис. 1.36   Знаки перевода строки 
разделяют имена в столбце B
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Быстрое удаление каждой N-ой строки
Иногда при работе с Excel приходится проявлять изобретательность, и, если 
искомый текст не получается обнаружить напрямую, можно создать вспомо-
гательный столбец для выполнения задачи.

В этом примере у нас есть данные о продажах со вставленными итоговыми 
строками, от которых нам необходимо избавиться. Эти строки помечены на-
званиями регионов, так что на какой-то конкретный текст в данном случае 
мы ориентироваться не можем. Зато мы знаем, что итоги идут строго через 
пять строк.

Чтобы решить эту задачу, создадим вспомогательный столбец с символа-
ми, причем в каждой пятой строке будем использовать символ, отличающий-
ся от остальных, как показано на рис. 1.38.

1.	� В столбце C введите по символу напротив каждой продажи в первых 
пяти строках, при этом последний символ должен отличаться от пре-
дыдущих.

2.	� Выделите эти пять ячеек и протяните вниз, чтобы создать последова-
тельность символов. Вы можете сделать это быстрее, дважды щелкнув 
по маркеру заполнения.

Рис. 1.38   Генерируем последовательность символов  
для идентификации нужных нам строк

3.	� В диалоговом окне Найти и заменить введите выбранный вами уни-
кальный символ в  поле Найти и  нажмите на кнопку Найти все для 
поиска всех нужных нам строк.

4.	� Нажмите сочетание клавиш Ctrl+A для выделения всех ячеек, как по-
казано на рис. 1.39.

5.	� Перейдите в  меню Главная ⇒ Удалить ⇒ Удалить строки с листа 
(Home ⇒ Delete ⇒ Delete Sheet Rows), чтобы удалить каждую пятую 
строку.

Alexander Ginko
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Рис. 1.39   Выбор всех ячеек с уникальным символом

Быстрый поиск ячеек, 
удовлетворяющих критерию

Инструмент Выделить группу ячеек (Go To Special) невероятно полезен 
и  позволяет выбрать сразу все ячейки, удовлетворяющие определенному 
критерию. Его очень удобно использовать при проверке рабочих листов 
и выполнении больших задач.

Файл: go-to-special.xlsx

Удаление пустых строк
С проблемой пустых строк сталкиваются в тот или иной момент времени все 
пользователи Excel. Но на наше счастье в арсенале Excel есть такой сияющий 
рыцарь, как инструмент Выделить группу ячеек, который безвозмездно 
поможет вам одним взмахом руки избавиться от них.

Alexander Ginko
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Примечание. При помощи выделения группы ячеек можно легко и быстро выполнить 
задачу удаления пустых строк на листе. В  главе 5 мы познакомимся с  инструментом 
Power Query, который позволяет решать эти и многие другие задачи более эффективным 
способом.

На рис. 1.40 показан фрагмент данных, которые мы получили из внешне-
го источника. Нам необходимо избавиться от пустых строк, следующих за 
каждым периодом.

Рис. 1.40   Пустые строки на листе. Плохие новости!

1.	� Выделите диапазон ячеек, в  которых нужно избавиться от пустых 
строк. В  нашем случае я  просто выделю столбец A, поскольку этого 
будет вполне достаточно для поиска пустых строк.

2.	� Нажмите на клавишу F5 для открытия окна Переход (Go To), после чего 
нажмите на кнопку Выделить (Special). Либо откройте в меню пункт 
Главная ⇒ Найти и выделить ⇒ Выделить группу ячеек (Home ⇒ 
Find & Select ⇒ Go To Special).

3.	� Установите переключатель в положение Пустые ячейки (Blanks), как 
показано на рис. 1.41, и нажмите на кнопку OK.

Все пустые ячейки в выбранном диапазоне будут выделены. Теперь можно 
удалить соответствующие строки.

4.	� Перейдите в  меню Главная ⇒ Удалить ⇒ Удалить строки с листа 
(Home ⇒ Delete ⇒ Delete Sheet Rows).
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Рис. 1.41   Выберите пункт Пустые ячейки  
в окне Выделить группу ячеек

Заполнение пустых ячеек нулями
Помимо пустых строк, которые необходимо удалять, существует и  другая 
распространенная проблема, связанная с пустыми ячейками.

На рис.  1.42 показан фрагмент таблицы данных с  разбросанными в  ней 
пустыми ячейками. Нам необходимо заполнить их значениями. В данном 
случае мы будем заполнять их нулями.

Рис. 1.42   Пустые ячейки в наборе данных
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1.	� Выделите диапазон, в котором присутствуют пустые ячейки. В данном 
примере выделим столбцы с B по E.

2.	� Откройте в меню пункт Главная ⇒ Найти и выделить ⇒ Выделить 
группу ячеек, установите переключатель в положение Пустые ячейки 
и нажмите на кнопку OK.

3.	� Все пустые ячейки в диапазоне будут выделены. При этом активной 
будет первая из них, что видно по рис. 1.43.

Рис. 1.43   Быстрое выделение всех пустых ячеек в диапазоне

4.	� Введите ноль на клавиатуре. Введенное значение появится только 
в активной ячейке. Нажмите сочетание клавиш Ctrl+Enter, чтобы рас-
пространить это значение на все выделенные ячейки, как показано на 
рис. 1.44.

Рис. 1.44   Нули во всех пустых ячейках
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